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Chapter 1. Designer Overview 
 

MakeAFP Form Designer for Windows provides a truly user-friendly WYSIWYG graphical 
interface to empower you to visually create superior AFP overlays quickly, reducing your 
design time and improving your productivity tremendously. 

Functions at a Glance 
 

MakeAFP Form Designer provides the following advanced features and functions helping you  
to create your AFP overlays at ease: 
 

 WYSIWYG GUI in superior presentation quality and High-performance. 
 

 Supports legacy AFP ASCII/EBCDIC/DBCS-PC/DBCS-HOST encoding FOCA bitmap and 
outline fonts, as well as using a new generation of OpenType/TrueType fonts directly, able 
to selects a font by the properties of typeface name, style, and size, able to scale outline 
font width.  

 

 Supports legacy AFP page segment monochrome and full-color images in FS10, FS11, FS42, 
and FS45 formats. 

 

 Supports data-object containers in AFP page segment, GIF, JPEG, PDF, and TIFF formats. 
 

 Supports ICC profile-based color management natively. 
 

 Supports legacy lines, boxes and shading patterns LED, SCREEN and STANDARD. 
 

 Supports AFP GOCA vector graphic drawings, such as a color graphic table, box, rounded 
corner box, line, arrow-line, fillet, marker, ellipse, arc, circle, etc. 

 

 Able to control GOCA vector line width and styles; area filling patterns and colors; curves of 
each corner of the rounded box. 

 

 Able to repeat drawing of line, box, rounded box, shading, color area precisely. 
 

 Accurate positioning of all types of elements/objects with mouse or keyboard input in 
units of inches, millimeters, centimeters, or points. 

 

 Displays positioning/sizing parameters in real-time along with the element/object. 
 

 Auto-snap positioning while aligning element/object with the relevant element/object. 
 

 Supports ASCII/EBCDIC/DBCS-PC/DBCS-HOST and UTF-8/ UTF-16 texts and paragraph 
rotations and alignments of left, center, right, and justify. 

 

 Able to enter universal texts by keyboard and copy/paste at ease. 
 

 Supports zoom levels of the entire page, page width, zooming from 25% to 500%, or a 
user-specify zoom level.  

 

 Able to use grids and guidelines to facilitate AFP overlay design. 
 

 Supports copy/cut/paste, undo/redo, drag and drop elements/objects. 
 

 Supports both legacy monochrome and full-color elements/objects. 
 

 Supports graphic rulers with choice of units. 
 

 Able to use the scan-in image as the form Template with choices of color control. 
 

 Supports all popular types of 1D and 2D barcodes by AFP drawing, including the new US 
Postal 4-State OneCode barcode.  

 

 Able to import IBM OGL source code. 
 

 Able to export C/C++ source code for MakeAFP Formatter. 
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Starting MakeAFP Form Designer  
 

To start MakeAFP Form Designer: 
 

1. Click the Start button. 

2. Select Programs, MakeAFP Software, and then AFP Form Designer. 

 

    Or, double-click the AFP Form Designer icon on your desktop. 
   

Parts of the Form Designer Interface  
 

Form Designer provides all the tools you need to create the elements/objects of texts, vector 

graphic draws, barcodes, images, etc. The following overview identifies some basic features of 

the Form Designer interface.  

 
Top Portion of the Interface 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Title Bar - shows the 
name of the active form 
project  name. 

Menu Bar - gives access to most features. 
Menus are contextual. 

Main Toolbar - gives quick access to frequently 
used functions such as new, open, save, print, 
cut, copy, paste, undo, redo, zoom, component 
properties of vector graphic, text, font, etc. 

 

Middle Portion of the Interface 
 

Shortcut Menu - right-click to 
display. It gives a list of options you 
can perform on a selected object's 

Tools Toolbar - Selection, Text, 
Paragraph, Line, Box, Image, 
Barcode and AFP vector graphic 
drawing tools. 
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Bottom Portion of the Interface  
 

 
 
 
 
 
 
 

Status Bar - Gives you information about the 
current active overlay name, measurement units, 
position and size of the selecting object. 

 
 
 
 
 
 
 
 
 

MakeAFP Form Designer Prerequisites  
 

Here are the prerequisites to run MakeAFP Form Designer: 
 

1. Windows 7 or above.  
 

2. Microsoft Visual C++ 2010 SP1 Redistributable Package (x86). 

 

http://www.makeafp.com/formatter4.htm
http://www.makeafp.com/formatter4.htm
http://download.microsoft.com/download/1/6/5/165255E7-1014-4D0A-B094-B6A430A6BFFC/vcredist_x86.exe
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Chapter 2. Designer Menu Bar 
 

The Menu Bar in MakeAFP Form Designer is similar to most Microsoft Windows-based software 
interfaces. Additional features are available and their purposes are outlined in the following 
narrative.  

 

Some of the menu bar features appear only after you have opened a project file in Designer, 
and some options will appear dimmed depending on what items you have made active by 
selecting them. 

 

Using the Menu Bar  
 

Click on an item in the Menu Bar to view its options. Available options and shortcut keys are 
displayed adjacent to the item, and menu options are context-sensitive.  
 

 

 

 

 

 

 
 
 
 
 
 
 
 
 

You can also access an item in the Menu Bar by ALT + the underscored letter in the Menu 
Bar. For example, ALT+F brings up the File Menu.  

Menu Bar with Underscores                                          Menu Bar without Underscores 

 
 

Options Under the Menu Bar  
 

Most of the options under the Menu Bar should be self-explanatory to any experienced 

computer user. For example, you should be able to comprehend how to open, close, and print 

a file as in any Microsoft Windows-based program. 
 

Some options may be dimmed as they are not available due to the status of the selected object, 

or because no object is selected.  

 
The Menu Bar and options are listed in the following tables sequentially: 
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Menu Option Functions 
 

File  

 

When there is a project opened, the File Menu options available are: 
New, Open, Close, Save, Save As, Create AFP Overlay, Preview AFP 
Overlay, Import OGL, Print, Print Preview, Recent Projects, and Exits. 
 

 
 

New - begins a new project of Designer. 
Open – opens an existing project of Designer. 
Close - closes the active window, giving you a chance to save the 
               project if it is not saved. 
Save - saves the active project. 
Save As - saves the active project as another project. 
Create AFP Overlay – creates an AFP overlay object from the current 
                                             active AFP overlay design page. 
Preview AFP Overlay – previews the overlay in AFP format by the  
                                                MakeAFP Viewer Lite. 
Import OGL – imports a source code file in IBM OGL format. 
Print or Print Preview - bring up the print or print preview dialog box. 
Recent Projects - A list of the most recent projects opened in Designer. 
Exit - closes the active window, giving you a chance to save any 
            the unsaved project then exits Designer. 
 

 

Edit  

 

 

The Edit Menu offers some basic options for edit overlay, overlay setup, 
and overlay properties. 
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Menu Option Functions 

 

Edit  

 

Undo - takes you one step back in the order of the operations you have 
               performed.  
Redo - takes you one step forward in the order of the operations you 
              have performed.  
Cut - removes the active object/element from your drawing window. 
Copy - makes a copy of the active object/element in your drawing 
               window and keeps it in memory.  
Paste - takes a copy of the object/element in memory and places it in 
               your drawing window.  
Delete - removes the active object/element from your drawing 
                  window.  
Select All - selects all of the objects/elements in your drawing window 
                       and makes them active.  
Copy Parameter – Let’s copy the parameter in C++ source code 
                                      format. 
Align – Aligns a group of objects selected.  
Arrange – Arranges the presentation layer of the object selected.  
Overlay – Let’s insert and delete an overlay. Designer allows you to 
                     define multiple overlays within one project. 
Overlay Setup – defines the overlay name and size.  
Project Properties – defines the properties of the project. 
 

 

Insert 

 

The Insert Menu allows you to insert these objects: Text, Paragraph, 
Lines, Boxes, Shapes, Picture, Page Segment, Barcode, and Symbol. 
 

 
 

Line Text- inserts a single-line text.  
Paragraph – inserts a text paragraph. 
Lines - inserts the legacy or vector line(s). 
Boxes – inserts the legacy or vector box(es).  
Shapes – inserts the vector drawing shape(s).  
Table – inserts a table. 
Data Object – inserts a data object in GIF/JPEG/PDF/TIFF formats.  
Page Segment – inserts a legacy monochrome image in AFP page  
                                   segment format. 
Barcode – inserts a 1D or 2D barcode object. 
Symbol – inserts a special symbol, only available by using UTF-8/UTF-16 
                    encoding with an OpenType/TrueType font. 
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Menu Option Functions 
 

View  

 

The View Menu allows you to control the viewing of these options: 
Toolbars, Status Bar, Display Quality, Form Template, Ruler, Show Grid, 
Snap to Grid, and C++ Source Code. 
 

 
 

Toolbars – allows you to select the types of toolbars to be displayed on  
                       the design window.  
Status Bar – selects whether to display the status bar at bottom of the 
                          design window.  
Display Quality – selects the display quality.  
Form Template – allows the import and display of a scan-in image from  
                                    preprinted form as the Template. 
Rulers – controls whether display the rulers with the design window.  
Messages – shows the warning and error messages. 
Show Grid – controls whether display the grid. 
Snap to Grid – controls whether snap to the grid line.  
C++ Source Code – shows the MakeAFP Formatter C/C++ source code  
                                        generated by Design.  
 

 

Options 

 
 

The Options Menu allows you to customize the default options, AFP 
FOCA font library, color management default ICC color profiles; chooses a 

color theme for your GUI; selects a language for your Menu, edit and 
create the Language Files. 
 

 
 

Customize Options – defines the default options to customize your  
                                            Designer. 
AFP Fonts – customizes the AFP FOCA fonts library.  
Theme – chooses a color theme for your GUI. 
Languages – chooses a preferred language for the Menu, edits or  
                            creates the language files. 
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Chapter 3. Designer Toolbars 
 

MakeAFP Form Designer contains a suite of tools to help you to create AFP overlays at ease. 
The tools are arranged on toolbars for convenient access, many of them are also available on 
the menus. 

 

Standard Toolbar  
 
 
 

 

Tool Function 

 
 New Project 

 

Let’s open the Create New Project dialog box. 

 
Open Project 

Let’s Open an existing project file. 

 
Save Project 

Let’s Save the current project. 

 
Preview AFP Overlay 

Let’s Preview the AFP overlay by the MakeAFP Viewer 
Lite. 

 
Print 

Let’s Print the designs of the current project. 

 
Insert Overlay 

Let’s insert a new AFP overlay in the project. 

 
Remove Overlay 

Let’s remove an AFP overlay from the project. 

 
Overlay Setup 

Let’s set up an AFP overlay. 

 
Undo 

Let’s reverse the last action. 

 
Redo 

Let’s reverse Undo. 

 
Cut 

Let’s Cut the selection and put it on the clipboard. 
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Tool Function 

 
Copy 

Let’s Copy the current selection to the clipboard. 

 
 Paste 

 

Let’s Paste the last item on the clipboard into the 
current design window 

 
Delete 

Let’s Delete the current selection. 

 
Select All 

Let’s select all elements on the current page. 

 
Show Ruler 

Let’s Show Ruler or not. 

 
View Scale 

Let’s select the zoom level. You can select: 
Entire Page, Page Width, zooming from 25% to 500%, 
or specify a user-specify zoom level.  

 

Tools Toolbar  

 
Tool Function 

  
 Select 

 

Let’s make objects active or current by clicking on them 
with this tool. 
 

 
Line Text 

Let’s insert a single-line text string. 

 
Paragraph 

Let’s insert a text paragraph. 

 
Straight Line 

Let’s draw straight lines, both legacy text line and AFP 
vector graphic line are supported.  
 

You can draw multiple lines successively while holding 
down the  CTRL key. 

 
Box 

Let’s draw boxes, both legacy boxes with shading and 
AFP vector box with the color background are 
supported. 
 

You can draw multiple boxes successively while 
holding down the  CTRL key. 

 
Table 

Let’s insert a table. 

 
Image 

Let’s insert an image, both legacy AFP page segment 
and data-object containers of GIF, JPEG, PDF, and TIFF 
are supported. 

 
Barcode 

Let’s to insert linear or 2D barcodes. 
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Formatting Toolbar  
 
 
 

 

Tool Function 

 
 Font Items Drop-Down 

 

Let’s select an OpenType/TrueType or AFP FOCA 
bitmap/outline font from the font list. 

 
Font Size Combo Box 

Let’s select from a list of Font sizes or specify a font size 
for outline font. 

 
Underline 

Let’s underline the text. 

 
Align Left 

Let’s align text horizontally left. 

 
Align Center 

Let’s align text horizontally center. 

 
Align Right 

Let’s align text horizontally right. 

 
Justify 

Let’s align paragraph text horizontally justified. 

 
Text Color 

Let’s change the color of the text. RGB, CMYK, and AFP 
OCA (Object Content Architectures) colors are 
supported. 

 
 
 

Shapes Toolbar  
 

Tool Function 

 
 Skew and Arrow Line 

 

Let’s draw a vector skew line, arrow line, or double 
arrows line.  
 

You can draw multiple skews or arrow lines successively 
while holding down the  CTRL-key. 

  
Rounded Box and 
Diamond 

Let’s draw a vector rounded box or diamond.  
 

You can draw multiple boxes or diamonds successively 
while holding down the  CTRL-key. 

 

 
Ellipse, Circle, Pie, and 
Partial Ellipse 

Let’s draw a vector ellipse, circle, pie, or partial ellipse. 
 

You can draw multiple ellipses, Circles, Pies, or partial 
ellipses successively while holding down the  CTRL-
key. 
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Tool Function 

 

 
Polyline, Polygon, Fillet 
and Fill Fillet 

Let’s draw a vector poly-line, polygon, fillet, or fill-fillet. 

 
Marker 

Let’s insert a vector GOCA marker. 

 

Line and Filling Toolbar  
 
 
 

 

Tool Function 

 
 Line Style 

 

Let’s select a vector line style. 

 
Line Width 

Let’s specify the line width as a multiplier of the normal 
line width (which is approximately 0.01 inches). 
Supported values for the AFP vector line by your IPDS 
printers may be up to 13 only, which is about 0.13 
inches. 

 
Line Color 

Let’s select a color for the line. RGB, CMYK, and AFP 
OCA (Object Content Architectures) colors are 
supported. 

 
Fill Pattern 

Let’s select a filling pattern for the area of the AFP 
vector graphic. 

 
Fill Color 

Let’s select a filling color for the area of the AFP vector 
graphic. RGB, CMYK, and AFP OCA (Object Content 
Architectures) colors are supported. 

 

Layout Toolbar  
 

 
 

 
 

Tool Function 

 
 Align Left 

Let’s align selected objects horizontally left. 

 
Align Center 

Let’s align selected objects horizontally center. 
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Align Right 

Let’s align selected objects horizontally right. 

 
Align Top 

Let’s align selected objects vertically top. 

 
Align Middle 

Let’s align selected objects vertically middle. 

 
Align Bottom 

Let’s align selected objects vertically bottom. 

 
Make Same Size 

Let’s make selected objects the same size. 

 
Make Same Width 

Let’s make selected objects the same width. 

 
Make Same Height 

Let’s make selected objects the same height. 

 
Bring to Front 

Let’s bring the selected vector drawing object to the 
front of all the vector objects on the screen. 

 
Bring to Back 

Let’s send the selected vector drawing object to the 
back of all the vector objects on the screen. 

 
Move Forward 

Let’s bring a vector object forward one step at a time. 

 
Move Backward 

Let’s move a vector object backward one step at a time. 

 
Lock 

Let’s lock an object on the screen. When an object is 
locked, it is in an inactive status and cannot be 
edited. 

 

Dynamic Parameters Toolbar 
          

 

For Line
 
 
 
 
 
 

   For Box 
 
 
 

 
 
 

For Circle or Pie 
 
 
 
 
 
 
 

For Ellipse

For Text Paragraph
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Tool Function 

 
 X Position 

 

Shows the X position of an object, also allows you to 
enter its position manually. 

 
Y Position 

Shows the Y position of an object, also allows you to 
enter its position manually. 

 
Length 

Shows the length of the line, also allows you to enter a 
value manually.  

 
Width 

Shows the width of the box or text paragraph, also 
allows you to enter a value manually. 

 
Height 

Shows the height of the box, also allows you to enter a 
value manually. 

 
Radius 

Shows the radius of the circle or pie, also allows you to 
enter a value manually. 

 
Axis 

Shows the axis parameters of the ellipse, also allows 
you to enter their values manually. 

 
Rotation 

Shows the rotation of the ellipse, also allows you to 
enter a value manually. 

 
LPI 

Shows the line spacing of text paragraph by LPI (Lines 
Per Inch) unit, also allows you to enter a value manually. 
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Chapter 4. Customize Options 
 

The Designer Options let you open the dialogs to view and define the default configuration. 
With option customizations, you can define the general settings for the measurement units, 
default input data encoding, font types, AFP data encoding, default font, language locale, grid, 
default ICC RGB/CMYK profiles, as well as customize the AFP FOCA font library, etc. 

 

General Options  
 

You can access the Designer General Options by opening the Options Menu and then 
selecting the Customize Options. 
 
General Options Tab: 
 

 
 

 

With General Options, you must make sure the following settings are defined properly: 
 

         Input Data Encoding Must match with your default PC text input encoding.  
 

Font Type Choose whether use OpenType/TrueType fonts, AFP FOCA 
fonts, or both font types. 
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         AFP Data Encoding  Choose default AFP text data encoding, Auto-Encoding is  
    recommended.   
 

ASCII/EBCDIC Codepage Choose an AFP 1-byte codepage as the default for the AFP 
text encoding either in ASCII or EBCDIC. Select an EBCDIC 
codepage if AFP overlay is created for IBM mainframes and 
OS/400.  

 

Default DBCS Codepage Choose an AFP 2-byte codepage as the default to be used 
for the AFP DBCS texts. 

 

Default Font Choose an OpenType/TrueType font as the default font for 
the AFP texts encoding in ASCII/ EBCDIC/UTF16-BE/UTF8, or 
an AFP 1-byte FOCA font for AFP texts encoding in 
ASCII/EBCDIC.  

 
 

Default DBCS Font Choose an OpenType/TrueType font or AFP 2-byte FOCA 
Font as the default font for the AFP DBCS-PC/DBCS-HOST 
texts.  

 

Locale Must match with your language locale.  
 

Grid Options  
 

You can access the Designer Grid Options by opening the Options Menu, selecting the 
Customize Options and clicking on tab Grid. 

 
Grid Tab: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 
With Grid Options, we can set whether to show grid, snap to grid, as well as choose grid type, 
size and color. 
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Color Settings  
 

You can access the Designer Color Settings Options by opening the Options Menu, selecting 
the Customize Options and clicking on tab Color Settings. 
 
Color Settings Tab: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
With Color Settings Options, you can select the default RGB and CMYK ICC profiles for color 
management. 
 
Designer supports ICC-based color management natively in High-performance for the CMYK 
texts, GOCA vector graphics, and images, it supports CMYK images embedded with ICC profiles, 
or use the CMYK ICC profile you selected with the Color Management setting or the default 
CMYK ICC profile “U.S. Web Coated SWOP v2”, if CMYK image did not embed an ICC profile.  
 
With Windows Explorer, you can right-click your ICC profile files and then install them into your 
Windows system. 
 

You can download the Adobe ICC profiles for Windows from Adobe website. Check with your 
AFP printer vendors for the CMYK ICC profile specially developed for your color IPDS printers. 
  

http://www.adobe.com/support/downloads/product.jsp?product=62&platform=windows
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Other Options  
 

You can access the Designer Others Options by opening the Options Menu, selecting the 
Customize Options, and clicking on tab Others. 
 
Others Tab: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

With Others Options, you may want to change the following two settings: 
 

Font Checking Notification Delay Defines the display time of warning message in 
milliseconds. The designer always checks the 
typing text with the font selected to see whether 
they are matching, otherwise shows a warning 
message, for instance, if you are using font Arial 
with a Chinese, Japanese or Korean text. 

 

Default AFP Resource Directory Defines the default resource directory of your 
images and output overlay, you may either define a 
fully qualified pathname being used as a central 
resource library of images and overlays or a relative 
sub-path.\reslib under the project file directory. 

 

AFP Document Viewer Defines a third-party AFP Viewer for previewing of 
overlay in AFP format, default is using the MakeAFP 
Viewer Lite integrated within the MakeAFP Form 
Designer. 
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Customize AFP FOCA Fonts Library  
 

You can invoke the AFP FOCA Font Library by opening the Options Menu, and then selecting 
AFP FOCA …. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

With the AFP FOCA Font Library, you can easily define or modify the AFP font directories, build 
or re-build the AFP FOCA font list, and edit and remove any item under the AFP FOCA Font List. 
Alternatively, you can also manually edit and improve the.\config\font.xml configuration file of 
the AFP FOCA font library. 
 
Designer supports AFP ASCII/EBCDIC, DBCS-HOST/DBCS-PC bitmap and outline fonts, as well as 
AFP FOCA outline font in UTF-16BE encoding.  
 
For the 1-byte of ASCII/EBCDIC AFP fonts, Designer not only supports using AFP coded font, 
but is also able to use an AFP character-set directly with a codepage, either defined by the 
option of Default ASCII/ EBCDIC Codepage under the project properties or defined under the 
AFP FOCA Font Library where you can edit an item of the character-set to manually define a 
codepage to be used with that AFP font character-set.  
  
For the 2-byte of DBCS-PC, DBCS-HOST, and UTF16BE AFP fonts, AFP coded fonts are required 
by the Designer.  

 
Refer to Appendix B. AFP Font Basic Concepts, for some more information about AFP FOCA fonts, 
and refer to MakeAFP Fonter User’s Guide on how to create and update AFP FOCA bitmap and 
outline fonts.  

 

Customize AFP FOCA Font Items  
 

Under AFP FOCA Font List on the AFP FOCA Font Library window, you may want to edit an 
AFP font item, for instance, you may change its typeface name if you dislike the original AFP 
typeface name extracted from the AFP FOCA font files.  



 

- 19 - 

 

 
 
 
 
 
 
 
 
 
 

 
With IBM legacy DBCS-HOST 240-dpi bitmap fonts developed before 1990 for Chinese, 
Japanese, and Korean, you have to manually select the “Map to encoding” option, as these 
legacy DBCS bitmap fonts used non-standard GCGIDs.  
 
In the IBM AFP fonts standard, each character is assigned a unique 8-character GCGID (Graphic 
Character Global Identifier), for instance, the character uppercase A is assigned the GCGID 
LA020000 registered by IBM. These unique GCGIDs are also required by MakeAFP Designer for 
the mapping with Unicode.  

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Customize Overlay Setup  
 

The Overlay Setup Let’s customize the overlay name and size for an overlay. Designer allows 
you to create multiple AFP overlays within a project. 
 

Once a new overlay is created, you have two options to access its properties: 
 

1. Opening the Edit Menu, selecting the Overlay Setup. 
 

2. By right-clicking on a blank area of the design screen, then selecting the Overlay Setup.  
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Overlay Setup: 
 
 
 
 

 
 
 
 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

With the Overlay Setup, you can define the overlay name and size. 
 

Customize Project Properties  
 

The Project Properties let you customize some important options for each project. You may 
set the default measurement units, input data encoding, font type, default AFP codepage, and 
language locale. 
 

Once a new project is created, you have two options to access its Project Properties: 
 

1. Opening the Edit Menu, then selecting the Project Properties. 
 

2. By right-clicking on a blank area of the design screen, then selecting Project Properties. 
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    Project Properties: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Make sure the following settings are defined properly: 
 

         Input Data Encoding Must match with your default PC text input encoding.  
 

Font Type Choose whether to use OpenType/TrueType fonts, AFP 
FOCA fonts, or both font types.      

 

ASCII/EBCDIC Codepage Choose an AFP 1-byte codepage as the default for the AFP 
text encoding either in ASCII or EBCDIC. Select an EBCDIC 
codepage if AFP overlay is created for IBM mainframes and 
OS/400.  

 

Default DBCS Codepage Choose an AFP 2-byte codepage as the default to be used 
for the AFP DBCS texts. 

 

     Resource Directory Defines the resource directory of your images and output 
overlay for your current project, you may either define a fully 
qualified pathname or a relative sub-path.\reslib under the 
project file directory. 

 

Locale Must match with your current project’s language locale.  
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Chapter 5. Designer Objects and Template 
 

Drawing, image, barcode, text, and table are the objects that can be graphically created, 
inserted, and manipulated by MakeAFP Designer. All objects have their properties. When 

ects are created, they come into being with the default Properties.  obj      

Basic Object Operations 
 

When you clicking on an object, it becomes an active object. You may perform the following 
operations on an active object. 

 

Copying an Object 
To Copy an object to a new location, click on the object and press the CTRL+C keys down. The 
object is copied to the clipboard.  

 

Cutting an Object 
To Cut an object from a location, click on the object and press the CTRL+X keys. The object will 
be removed and placed on the clipboard. 

 

Deleting an Object 
To Delete an object from a location, click on the object and press the DELETE key. The object 
will be removed.  

 

Moving an Object 
When the object is active, and you click on it but not on a handle, a four-pointed arrow appears. 
That is the Move Icon. When the move icon is shown, you can drag the object to a new location. 
You can also move an object by the keyboard ARROW keys. 

 

Pasting an Object 
After you Copy or Cut an object, you can Paste it elsewhere by press CTRL+V keys. The pasted 
object is offset from the original when pasted on the current design screen. When pasting to a 
different design screen, the object remains at the same horizontal position, so that you can 
easily clone an object from one design screen to another. 

 

Resizing an Object 
To resize an object by dragging, select the object and place your pointer over one of the 
handles on it until it turns to a double-pointed arrow. Drag the handle in or out until the object 
is in the size you want. You can also resize an object by press Shift + Arrow keys. 
 

Undo and Redo on an Object 
You can undo an operation you have just performed on an object. Just press CTRL+Z keys. If 
you change your mind again, just can redo that operation again by press CTRL+Y keys. 
 

Select Multiple Objects 
You can drag your pointer diagonally over the objects you want to select, making sure that 
they are at least partially within the area you are defining. Handles will appear around all the 
objects you have selected. You can add objects to the group that is selected by holding down 
the SHIFT or CTRL key while selecting additional objects. You can also select more than one 
object at a time by holding down the SHIFT or CTRL key as you click on successive objects. You 
can select all objects by press  CTRL+A keys. 
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   Edit an Object Properties 
Object properties can be edited anytime once you double-click on an object. The designer 
also allows right-click on an object to display a context shortcut menu showing the object 
properties. 

 
 

    Sample – Vector Graphic Box’s Properties 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Drawing Objects 
 

Drawing objects are the lines, boxes, polylines, polygons, ellipses, circles, etc. Designer 
supports not only drawing with AFP vector graphics but also drawing legacy text lines and 
boxes with AFP monochrome color shading. 
 

To use a drawing tool on the Tools Toolbar and Shapes Toolbar, click on a drawing tool and 
then click on the drawing area to start drawing. You can also access the drawing tools under 
the Insert Menu. 
 

 
 
 
 
 
 
 

Shapes Toolbar 
for the AFP vector 
graphics drawing 

Box Tools allow 
drawing with 
both vector box 
and legacy box 

 
 

 Line Tools allow 
drawing with 
both vector line 
and legacy line 
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With the drawing objects, the Designer is capable of: 
 

 Set the AFP vector line width and styles, filling patterns and colors, curves of each corner 
of the rounded box. 

 

 Able to repeat drawing of line, box, rounded box, shading, color area precisely.  
 

 Accurate positioning of all types of elements/objects with mouse or keyboard input in 
units of inches, millimeters, centimeters, or points. 

 

 Displaying position/size parameters in real-time along with the object. 
 

 Auto-snapping the position while aligning an element/object with the relevant 
element/object. 

 

Image Objects 
 

The designer supports the data-object containers in GIF, JPEG, PDF, TIFF, and AFP page 
segment formats, as well as the ICC profile-based color management. Refer to Section Data 
Object Container Resources of Appendix A for more information. 
 
To use the image tool on the Tools Toolbar, click on either the Data Object or Page Segment 
tool and then click on a position of the design screen where you want to place the object. You 
can also access the Data Object or Page Segment tool on the Insert Menu. 
 
With the Data Object Tool, you can include a GIF, JPEG, PDF, TIFF, or AFP page segment as the 
data-object resource. Using a traditional base-filename up to 8 alphanumeric characters is 
recommended for the data object file, which should be supported by most of the latest AFP 
print server.  
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note:   File extension *.gif, *.jpg, *.pdf and *.tif are allowed in Designer is just for your convenience.  
 

Your AFP systems may only support the data object resources with base-filename up to 8 
characters, without any file extension or with filename extension *.OBJ.  

  
 
With the Data Object Properties, the Designer allows you to define the rotation in 
0/90/180/270 degree and mapping option of Center/Fill/Fit/Trim.  
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The following sample shows the Data Object Properties: 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

With the Page Segment Tool, you can select an AFP page segment image.  
 

Barcode Objects 
 

The designer supports the 1D and 2D barcodes as the special symbol drawing objects. Most of 
the popular barcode standards are supported, includes the new US Postal 4-State OneCode 
barcode. 
Click on the Barcode Tool on the Tools Toolbar and then click on the drawing area to start 
drawing a barcode object. You can also access the Barcode Tool on the Insert Menu. 
 

With the Barcode Properties, you can choose a 1D or 2D barcode type from the barcode type 
list:  
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Text Objects 
 

Texts are objects that can be manipulated. The designer supports two types of text objects, 
they are Line Text and Paragraph. The Line Text is a single-line text. 

 

To use the text tools under the Tools Toolbar, click on either the Line Text or Paragraph tool 
and then click on a position of the design screen where you want to place the texts. You can 
also access the Line Text and Paragraph tools under the Insert Menu. 
 

When you right-click on the text while it is an inactive mode, its shortcut menu appears: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

When you double-click on the text while it is inactive, it goes into the text edit mode, then you 
can make changes to the texts: 
 

 
 
 
 
 
 

 
Paragraphs in Designer can be formatted just like with a word processing program. You can 
align the text by using the alignment buttons on the Text Formatting Toolbar. You can 
change font, text size, text color, line spacing, and so on. 
 

Designer allows you to enter Chinese, Japanese and Korean texts on English (or other non-CJK) 
Windows by the use of IME (Input Method Editor) for CJK languages.  
 

Designer supports AFP texts in Auto-Encoding, UTF-8, UTF-16, and Legacy Encoding. 
 

With most of the drawing objects, associated paragraph texts can be added easily by pressing 
shortcut key F2 after clicking on the drawing object: 
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When you double-click on the associated paragraph texts while it is inactive, it goes to the text 
edit mode. 
 

 
 
 

Table Objects 
 

A table object is made up of rows and columns of cells that you can fill with texts. Tables are 
often used to organize and present information. 
 
Click on the Table Tool on the Tools Toolbar, the pop-up table dialog Let’s choose the number 
of rows and columns you want in the table, and then click on the drawing area to start drawing 
of a table object. You can also access the Table Tool on the Insert Menu. 
 
With the Table Properties, you can make changes to the table attributes at ease.  
 

Form Template 
 

The designer allows you to use an image scanned from a pre-printed form as the form template. 
The template does not become part of the new overlay, it is just to be used as a visual guide for 
the designing of a new overlay. 
 

You have two options to load a template: 
 

1. Opening the View Menu, selecting the Form Template. 

2. By right-clicking on any blank area of the design screen, then selecting the Form 

Template. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
PDF and images in BMP, GIF, JPEG, PNG, TIFF, and AFP page segment formats are supported.  
 
With short-cut keys CTRL+T, you can easily turn-on/turn-off the form template during your 
overlay designing. 
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Chapter 6. Designer Files and Resources 
 

This chapter gives some overviews to the Design project file, configuration files, as well as the 
AFP overlay creation. 
 
You may need to do some customizations to the Designer’s configuration files if required.  
       

Designer Project File 
 

The Designer Project File with the file extension *.mafd is an XML format file. You can open an 
existing project file by one of the following options: 
 

1. Opening the File Menu, then selecting Open. 

2. Clicking on the Open Project Toolbar.  

3. Double-clicking on a project file by the Windows Explorer.  
 

Designer Configuration Files 
 

The following customizable configuration files in XML format are supplied in the Designer’s 
sub-path..\config: 

  
BARCODE.xml  The configuration file of 1D and 2D barcodes. 
   

CODEPAGE.xml       The configuration file of AFP codepages for ASCII/EBCDIC/ 
DBCS-PC/DBCS-HOST. 

    

  DESIGNER.xml          The configuration file of MakeAFP Form Designer GUI. 
 

  ENCODING.xml        The configuration file of encoding conversion alias names. 
 

FONT.xml            The configuration file of AFP FOCA font library, which can be 
updated easily by the GUI of AFP FOCA Font Library.  
 

LOCALE.xml            The configuration file of the language locales. 
 

OGLFONT.xml        The font mapping table to be used by Importing OGL source 
code.  

 

You may need to do some customizations to this file by a 
text or XML editor, if you want to replace the legacy AFP 
bitmap fonts used in OGL with new TrueType/OpenType 
fonts or AFP FOCA outline fonts, or legacy AFP FOCA outline 
fonts with TrueType/OpenType fonts.  

   

During Importing OGL, the Designer always searches the 
AFP font from the AFP Font Library first, if it is found then 
the original AFP font will be used;  if the Designer could not 
find the AFP font from the AFP Font Library, then it searches 
the AFP font mapping from the OGLFONT.xml mapping 
table file; otherwise, the AFP font will be auto-mapped to 
Designer's default font, if it still could not find the AFP font 
mapping definition from the mapping table. 
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AFP Overlay Preview 
 

Designer supports previewing of AFP overlay by the MakeAFP Viewer Lite or calling a third-
party AFP Viewer. To preview your AFP overlay, open the File Menu, and then select Preview 
AFP Overlay. 
 
The designer embeds all required resources inline in an interim AFP file for you to preview the 
AFP overlay on AFP viewer. 
 
Note:  The resources are not allowed embedding within an AFP overlay, please do not use such an 

interim AFP file for previewing as your AFP overlay in an AFP production environment.    
 
 
 
 
 

Creating AFP Overlay 
 

Once you have completed the design of your overlay, you can create an AFP overlay easily by 
opening the File Menu, and then select the Create AFP Overlay. 
 
The AFP overlay name can be one to eight alphanumeric characters (a-z, A-Z, 0–9) and special 
characters (# $ @), including the two-character prefix O1, O1 prefix is required for the overlay to 
be used by PSF for z/OS, and it is also recommended for the AFP print servers for multi-
platforms. 

Resource Files 
 

With the Designer, you have to deal with 5 types of resource objects, AFP overlays, AFP page 
segments, GIF/JPEG/PDF/TIFF data-object, AFP FOCA outline fonts, and OpenType/TrueType 
fonts. 
 

The designer directly accesses the OpenType/TrueType fonts installed on your Windows 
system and the AFP FOCA bitmap and outline fonts under the AFP FOCA Font Library.  
 

Designer gathers the AFP page segments and data-objects under the Resources Directory you 
defined, and Resources Directory is also the default output destination of your AFP overlay. 

 

C/C++ Source Code 
 

The designer generates C/C++ source for MakeAFP users who are using MakeAFP Formatter. 
Refer to MakeAFP Formatter User’s Guide and MakeAFP Reference for more information about 
MakeAFP ultrahigh-speed formatting solution. 

Designer provides a very useful and user-friendly feature helping you work with your MakeAFP 
Formatter programming, it allows to you copy the parameters in C/C++ syntax from the active 
design element/object with the short-cut keys CTRL+M, and then you can quickly paste the 
C/C++ source code into your MakeAFP Formatter program with the short-cut keys CTRL+V. 
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Appendix A. Using Resources in an AFP System 
 

This Appendix provides some additional overview information on how to use some of AFP 
resources, such as using the data-object resources of GIF/EPS/JPEG/PDF/TIFF and 
OpenType/TrueType fonts in an AFP production system.  
 

The information provided in this Appendix is mainly based on the IBM and InfoPrint AFP 
systems, such as IBM Content Manager OnDemand for Multiplatforms, InfoPrint Manager for 
Windows and AIX, and InfoPrint ProcessDirector for Linux. You may use the information 

vided here as your reference if you are using other AFP systems. pro      

OpenType/TrueType Fonts 
 

The latest AFP systems have supported using OpenType/TrueType fonts directly in the AFP 
systems and IPDS printers.  
 

With your new generation of AFP systems, using OpenType/TrueType fonts directly is strongly 
recommended. The new support for the OpenType/TrueType font technologies in AFP  
provides you with significant benefits of: 
 

 Much more choices and flexibility for typefaces, particularly non-Latin typefaces. 
  

 A truly worldwide multilingual presentation environment through the support of     
Unicode. 

 

 Supporting data encoding directly not only in Unicode UTF-8 and UTF-16 but also legacy 
ASCII/EBCDIC/DBCS.  

 

 Migration towards a single font technology across all presentation environments. 
  

 Much better font loading and processing performance on the new generation of        
IPDS controller. 

 

 A much lower cost for typefaces and straightforward to use them at ease. 
  

 Avoid the font copyright issues for such font conversion from OpenType/TrueType font 
formats to AFP FOCA raster or outline font formats.  

 

MakeAFP Form Designer and MakeAFP Viewer support directly using OpenType/TrueType 
fonts installed on your Windows system which is recommended for better performance, or 
OpenType/TrueType fonts embedded inline within AFP document file if you need to embed 
them inline in AFP. 
 

OpenType/TrueType fonts are not required storing on the servers of IBM Content Manager 
OnDemand for Multiplatforms, you just need to make sure the relevant OpenType/TrueType 
fonts are available the Windows workstations of IBM Content Manager OnDemand Client. 
  
The Resource Access Table (RAT) is required by the AFP print server to send the OpenType 
and TrueType fonts to the IPDS printers if the fonts are not embedded inline within AFP file, 
RAT may also be required by some AFP application software, like IBM/InfoPrint ACIF if 
OpenType/TrueType fonts need to be embedded inline within an AFP file. RAT must be 
updated whenever OpenType/TrueType fonts are updated on the AFP print server. 
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The RAT resides in the font directories on your AFP print server, and there can be multiple 
RATs in an AFP system, but only one for each font directory, the filename of the RAT in IBM 
and InfoPrint AFP print server is hard-coded as IBM_DataObjectFont.rat., to be accessed by 
the InfoPrint Manager, InfoPrint ProcessDirector, and PSF via the font library searching list.  
 

You can create a RAT table for OpenType/TrueType fonts by the FontRAT utility of MakeAFP, 
InfoPrint AFP Resource Installer, and Canon PRISMAproduction Resource Preparer, etc.  
 
For the AFP overlays created by the MakeAFP Form Designer using OpenType/TrueType fonts, 
make sure the relevant OpenType/TrueType fonts are stored in the AFP print server font 
libraries and RAT tables are updated whenever any new OpenType/TrueType font is added. 
 

Although RAT is not required by the MakeAFP Formatter, which accesses OpenType/ 
TrueType fonts information directly, and also embed them inline into AFP file as the font 
resources, RAT is still required by the AFP print server if you do not want to embed such big 
CJK (Chinese, Japanese and Korean) OpenType/TrueType fonts as the inline resources. 
 

The latest AFP systems allow you to capture the inline OpenType/TrueType fonts embedded in 
the AFP file. The OpenType/TrueType font capture allows the latest IPDS printer to capture a 
downloaded font and treat it as if it were a printer-resident font. Treating a downloaded font as 
a printer-resident font improves performance for future jobs that use the same fonts. Printers 
retain captured fonts across job boundaries and power cycles.  
 

Refer to Chapter 26. Working with fonts of InfoPrint Manager for Windows: Procedure (S500-1073) 
for more information about how to use and capture OpenType/TrueType fonts. 
 

AFP FOCA Fonts 
 

MakeAFP Form Designer and MakeAFP Viewer support using AFP FOCA fonts from AFP 
resource libraries directly, and MakeAFP Viewer also supports AFP FOCA embedded inline in 
the AFP document file. 
 

AFP printing servers sending AFP FOCA fonts from AFP font libraries to IPDS printers directly. 
 

Refer to Chapter 15. Creating and managing resource-context objects of InfoPrint Manager for 
Windows: Procedure (S500-1073) for more information about how to define AFP resource 
libraries and the file extensions supported for the AFP FOCA fonts. 
 

AFP Page Segments 
 

AFP page segments are the image objects in AFP IOCA image formats, make sure they are 
available on your AFP systems, under the resources searching lists of AFP resource libraries or 
AFP page segment libraries. 
 

MakeAFP From Designer and MakeAFP Viewer support AFP IOCA images in FS10, FS11 formats 
for monochrome images, FS42, and FS45 formats for color images. 
 

AFP page segment name can be one to eight alphanumeric characters (a-z, A-Z, 0–9) and 
special characters (# $ @), including the two-character prefix S1, if there is one. S1 prefix is 
required for the page segment to be used by PSF for z/OS, and it is recommended for the AFP 
print servers for multi-platforms. 

 

When AFP server system finds more than one page-segment with the same base-filename in a 
resource directory, it selects the matching page segment by the following file extension search 
order: 
 

1.   No filename extension 
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2.   PSEG3820 

3.   PSEG38PP 

4.   PSG 

5.   PSE 
 

Data-object Container Resources 
 

GIF, EPS, JPEG, PDF, TIFF and AFP page segment can be used in the latest AFP systems directly 
as the data-object container resources. Using a data-object container as an object resource is 
more efficient when that object appears more than once in an AFP file; resources are 
downloaded to the IPDS printer or AFP Viewer just once and then repeating referenced as 
needed.  
 

MakeAFP Form Designer and MakeAFP Viewer support ICC-based color management natively 
in High-performance for the data objects in CMYK mode, ICC profile can be embedded inline in 
CMYK image, or use the default CMYK ICC profile you selected with Color Management 
settings options if CMYK image did not embed an ICC profile.  
 

With Windows Explorer, you can right-click your ICC profile files and then install them into your 
Windows system. 
 

You can download the Adobe ICC profiles for Windows from Adobe website. Check with your 
AFP printer vendors for the CMYK ICC profile specially developed for your color IPDS printers. 
 

MakeAFP Form Designer and MakeAFP Viewer support using the traditional AFP resource 
naming convention for the filename of the data-object, under which the base-filename can 
only be one to eight alphanumeric characters (a-z, A-Z, 0–9) and special characters (# $ @).  
 

Using the traditional AFP resource naming is recommended for the data object resources to be 
used on IBM z/OS mainframe system and across platforms compatibility.  
 
Although MakeAFP Form Designer and MakeAFP Viewer also allow you to use up to 250 
characters long filename for the object resources, additional software is required to create the 
RAT (Resource Access Table) for the long-name data object resources to be used by the AFP 
printing servers on Windows and Unix. For example, You may create RATs of data object 
resources by the InfoPrint AFP Resources Installer, Océ PRISMAproduction Resource Preparer, 
etc. 
 
When the AFP system finds more than one data-object with the same traditional base-filename 
in a directory, it selects the matching data-object by the following file extension search order: 
 

1.   No filename extension 
2.   OBJ 

 

AFP Overlays 
 

AFP overlays are the collections of coded information describing the elements of boxes, lines, 
shading, text, logos, and graphics on forms. When printed with variable data from AFP 
applications, overlays can replace the needs for the pre-printed forms.  
 

Make sure AFP overlays available on your AFP systems, under the resources searching lists of 
AFP resource libraries or AFP overlay libraries. 
 

AFP overlay name can be one to eight alphanumeric characters (a-z, A-Z, 0–9) and special 
characters (# $ @), including the two-character prefix O1, if there is one. O1 prefix is required for 
the overlay to be used by PSF for z/OS, and it is recommended for the AFP print servers for 
multi-platforms. 

http://www.adobe.com/support/downloads/product.jsp?product=62&platform=windows
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When AFP server system finds more than one overlay with the same base-filename in a 
resource directory, it selects the matching overlay by the following file extension search order: 
 

1.   No filename extension 

2.   OVLY3820 

3.   OVLY38PP 

4.   OVL 

5.   OLY 

6.   OVR 

Transferring AFP Files and Resources 
 

Make sure FTP is in binary mode if you need to transfer AFP files and resources across multi-
platforms. 
 

For uploading AFP files and resources to z/OS, z/VSE and z/VM, you may need to use IBM AFP 
Reblocking Utility, more information and downloads are available at IBM webpage for AFP 
software.   
 

For uploading of AFP resources to OS/400, refer to Appendix D of  Advanced Print Utility User's 
Guide (S544-5351) or AS/400 Guide to Advanced Function Presentation and Print Services Facility 
(S544-5319) for more information. 

ftp://service.boulder.ibm.com/printers/tools/mvsvmreblk
ftp://service.boulder.ibm.com/printers/tools/mvsvmreblk
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Appendix B. AFP Font Basic Concepts 
 

This appendix introduces some basic AFP font terminology, structure and how characters are 
represented in digitized presentation type.  

AFP Font Structure  
 

In AFP font terminology, an AFP FOCA font has three components: 
  

 Coded font   
 Character set   
 Codepage  

 

 
 
 
 

 
 
 

 

Coded Font 
 

AFP coded font is a font file that associates the AFP character set with AFP codepage.  
 

A bitmap coded font consists of two parts: 
  

 References to specific character sets 
 References to specific codepages 

 

An outline coded font consists of three parts: 
  

 References to specific character sets 
 References to specific codepages 
 References to point size 

Character Set 
 

AFP character set consists of a finite set of characters. It contains information about a font 

type family, typeface, and point size, and also includes each character properties and its 

printing attributes, such as baseline positioning, rotation, ascenders, descenders, etc.  
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Characters 
 

Characters are the letters, numerals, marks, and symbols of a font. 
 

Character Properties 
 

Character properties detail how a character is positioned relative to the characters 
round it. Some character properties include the following: a

  
 The baseline of a character showing its general alignment 
  The dimensions of space in which the character is printed  

 The position of the character within that space  
 The identifier of the character (the character ID)  
 

One of the character properties is the character ID, named GCGID (graphic character global 
identifier). Each character is assigned a unique 8-character GCGID; for instance, the character 
uppercase A is assigned the GCGID LA020000 registered by IBM. 
 

For a list of GCGIDs, the character each represents, and the codepages where the characters are 
found, refer to IBM AFP Fonts: Technical Reference for Codepages (S544-3802-02). 
 

Printing Attributes 
  
The printing attributes define how the character set will be printed, such as baseline 
positioning, rotation, ascenders, descenders, and point size, etc. 
 

Single-byte and Double-byte Character Sets 
 

A single-byte character set (SBCS) is a font character set to be used with a single-byte 

codepage. The maximum number of characters in a character set is 256. 
 
A double-byte AFP bitmap font consists of multiple sections of double-byte character sets 
(DBCS), to be used with CJK (Chinese, Japanese, Korean).  
 

Bitmap Format of Character Set 
 

AFP font character sets in bitmap format can be in 240/300/600 dpi, some printers and AFP 
print server may support character sets in 360/480/720 dpi also. The character positioning 
values in the bitmap character set can be expressed in either fixed-metric or relative-metric.  
 

Outline Format of Character Set 
 

AFP outline character sets can be in SBCS outline format (by Adobe Postscript Type 1 outline 
font encapsulated in AFP font architecture wrappers), or DBCS outline format (by Adobe 
Postscript CID-keyed outlines font encapsulated in AFP font architecture wrappers). The 
character positioning values in the outline character set are expressed in relative-metric.  

Codepage 
 

AFP codepage maps each character of text to the characters in an AFP character set. As you 

enter your text on your keyboard, each key in character is translated into a hexadecimal code 

point. When the text is printed, each hexadecimal code point is matched to a GCGID on the 

AFP codepage you specified. The GCGID is then matched to the AFP bitmap pattern or outline 

vector pattern of the character in the AFP character set you specified. The character pattern in 

the character set is being finally used for the printing of your character. 

 

The following picture shows an example with AFP EBCDIC codepage T1V10037 for IBM 
mainframe USA English.  
 
When the IPDS printer receives EBCDIC hexadecimal code point C1, it prints an uppercase A, 
whose GCGID is LA020000. 
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A SBCS codepage contains up to 256 one-byte code points. SBCS codepages are good 
enough for languages with alphabetic writing systems, such as English, Latin, Greek, Thai, and 
Arabic, etc. 
 
A DBCS codepage can contain up to 65536 double-byte code points for CJK (Chinese, 
Japanese and Korean) languages.  
 
For bitmap DBCS AFP fonts, AFP treats DBCS codepage as a collection of single-byte 
codepages, a double-byte is split into two parts, the first byte indicating the section number 
of the codepage and the second byte indicating a code point within the section. 
 
For outline DBCS AFP fonts, AFP treats DBCS codepage as a single large codepage. Each DBCS 
character has a 2-byte code point. 
 

AFP Font Naming Convention 
 

Each AFP FOCA component’s name is only allowed up to 8 characters. The following list shows 

the prefix of the AFP font naming convention and the type of font component represents.  

 

AFP Font Name 
Prefix 

Font Component 

C0 The character set of AFP bitmap font 

CZ The character set of AFP outline font 

T1 AFP codepage 

X0 Coded font of AFP bitmap font 

XZ Coded font of AFP outline font 
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Appendix C. ASCII/EBCDIC AFP Codepages  Summary 
 

 

 
Name Description CPGID Encoding 

T1000038 US-ASCII Character Set 38 EBCDIC 

T1000259 Symbols, Set 7 259 EBCDIC 

T1000260 Canadian French - 116 260 EBCDIC 

T1000276 Canada (French) - 94 276 EBCDIC 

T1000286 Austria/Germany F.R., Alt (3270) 286 EBCDIC 

T1000287 Denmark/Norway, Alternate (3270) 287 EBCDIC 

T1000288 Finland/Sweden, Alternate (3270) 288 EBCDIC 

T1000289 Spain, Alternate (3270) 289 EBCDIC 

T1000290 Japan (Katakana) 290 EBCDIC 

T1000293 APL (USA) 293 EBCDIC 

T1000310 Graphic Escape APL/TN 310 EBCDIC 

T1000361 International Set 5 361 EBCDIC 

T1000363 Symbols, Set 8 363 EBCDIC 

T1000367 ASCII 367 ASCII 

T1000382 Austria, Germany, Japan 382 EBCDIC 

T1000383 Belgium 383 EBCDIC 

T1000384 Brazil 384 EBCDIC 

T1000385 Canada (French) 385 EBCDIC 

T1000386 Denmark/Norway 386 EBCDIC 

T1000387 Sweden/Finland 387 EBCDIC 

T1000388 France, Japan 388 EBCDIC 

T1000389 ITALY, Japan (Italian) 389 EBCDIC 

T1000390 Japan (Latin) 390 EBCDIC 

T1000391 Portugal 391 EBCDIC 

T1000392 Spain/Philippines 392 EBCDIC 

T1000393 Latin America (Spanish) 393 EBCDIC 

T1000394 U.K., Austral., IRE., H.K., N.Z. 394 EBCDIC 

T1000395 United States, Canada (English) 395 EBCDIC 

T1000420 Arabic Bilingual 420 EBCDIC 

T1000423 Greece - 183 423 EBCDIC 

T1000424 Israel (Hebrew) 424 EBCDIC 

T1000437 Personal Computer 437 ASCII 

T1000803 Hebrew Character Set A 803 EBCDIC 

T1000808 PC, Cyrillic, Russian with euro 808 ASCII 

T1000813 Greece - ISO/ASCII 8-Bit 813 ASCII 

T1000819 Latin1 ISO/ANSI 8-BIT 819 ASCII 

T1000829 Math Symbols 829 EBCDIC 

T1000836 Peoples Republic of China (PRC) 836 EBCDIC 

T1000838 Thai - EBCDIC 838 EBCDIC 

T1000848 PC, Cyrillic, Ukraine with Euro 848 ASCII 

T1000849 PC, Cyrillic, Belo Russian Euro 849 ASCII 

T1000850 PC Multilingual 850 ASCII 

T1000851 Greek - Personal Computer 851 ASCII 

T1000852 Latin2 Multilingual PC 852 ASCII 

http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000038_103_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000259_340_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000260_341_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000276_277_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000286_317_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000287_321_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000288_325_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000289_329_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000290_332_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000293_380_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000310_963_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000361_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000363_630_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000367_103_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000382_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000383_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000384_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000385_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000386_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000387_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000388_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000389_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000390_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000391_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000392_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000393_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000394_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000395_1145_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000420_235_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000423_218_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000424_941_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000437_919_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000803_1147_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000808_1385_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000813_925_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000819_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000829_909_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000836_936_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000838_1176_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000848_1390_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000848_1390_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000850_980_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000851_981_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000852_982_1994-12-16.htm


 

- 38 - 

 

T1000853 Latin3 Personal Computer 853 ASCII 

T1000855 Cyrillic - Personal Computer 855 ASCII 

T1000856 Hebrew - Personal Computer 856 ASCII 

T1000857 Latin5 PC 857 ASCII 

T1000858 PC - Multilingual with euro 858 ASCII 

T1000860 Portugal - Personal Computer 860 ASCII 

T1000861 Iceland - Personal Computer 861 ASCII 

T1000862 Hebrew - Personal Computer 862 ASCII 

T1000863 Canadian French - PC 863 ASCII 

T1000864 Arabic - Personal Computer 864 ASCII 

T1000865 Nordic - Personal Computer 865 ASCII 

T1000866 Cyrillic #2 - Personal Computer 866 ASCII 

T1000867 Israel - Personal Computer 867 ASCII 

T1000869 Greece - Personal Computer 869 ASCII 

T1000870 Latin2 Multilingual 870 EBCDIC 

T1000872 Cyrillic PC with Euro 872 ASCII 

T1000874 Thai - Personal Computer 874 ASCII 

T1000875 Greece 875 EBCDIC 

T1000876 OCR-A ASCII 876 ASCII 

T1000877 OCR-B ASCII 877 ASCII 

T1000880 Cyrillic Multilingual 880 EBCDIC 

T1000889 Thailand 889 EBCDIC 

T1000892 OCR - A 892 EBCDIC 

T1000893 OCR - B 893 EBCDIC 

T1000897 Japan PC #1 897 ASCII 

T1000899 Symbols, Set 7 ASCII 899 ASCII 

T1000901 PC, Baltic - Multilingual w Euro 901 ASCII 

T1000902 8-bit Estonia with euro 902 ASCII 

T1000903 Peoples Republic of China - PC 903 ASCII 

T1000904 Republic of China (ROC) - PC 904 ASCII 

T1000905 Latin3 Multilingual 905 EBCDIC 

T1000910 APL ASCII 910 ASCII 

T1000912 Latin2 ISO/ANSI 8-BIT 912 ASCII 

T1000913 Latin 3, ISO/ASCII 913 ASCII 

T1000914 Latin4 ISO/ANSI 8-BIT 914 ASCII 

T1000915 Cyrillic ISO/ASCII 8-Bit 915 ASCII 

T1000916 Hebrew ISO/ASCII 8-Bit 916 ASCII 

T1000920 Latin5 ISO/ANSI 8-BIT 920 ASCII 

T1000921 PC, Baltic - Multilingual 921 ASCII 

T1000922 Estonia PC 922 ASCII 

T1000923 Latin 9 923 ASCII 

T1000924 Latin 9 EBCDIC 924 EBCDIC 

T1001002 DCF REL 2 Compatibility 1002 EBCDIC 

T1001003 U.S. Text Subset 1003 EBCDIC 

T1001004 IBM PC Desktop Publishing 1004 ASCII 

T1001008 Arabic ISO/ASCII 8-Bit 1008 ASCII 

T1001025 Cyrillic Multilingual 1025 EBCDIC 

T1001026 Latin5 1026 EBCDIC 

T1001027 Japanese (Latin) Extended 1027 EBCDIC 

T1001028 Hebrew Publishing 1028 EBCDIC 

T1001029 Arabic Extended ISO/ACSII 8-Bit 1029 ASCII 

T1001032 MICR, E13-B Combined 1032 EBCDIC 

T1001033 MICR, CMC-7 Combined 1033 EBCDIC 

T1001038 Symbols, Adobe ASCII 1038 ASCII 

T1001039 GML List Symbols 1039 EBCDIC 

T1001041 Japanese Extended - PC 1041 ASCII 

T1001042 Simplified Chinese Extended - PC 1042 ASCII 

T1001043 Traditional Chinese Extended PC 1043 ASCII 

http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000853_983_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000855_985_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000856_986_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000857_987_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000858_988_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000860_990_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000861_991_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000862_992_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000863_993_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000864_994_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000865_995_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000866_996_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000867_1360_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000869_998_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000870_959_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000872_1383_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000874_1176_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000875_925_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000876_968_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000877_969_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000880_960_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000889_1102_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000892_968_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000893_969_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000897_1164_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000899_340_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000901_1394_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000902_1392_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000903_1166_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000904_1167_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000905_1286_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000910_1113_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000912_959_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000913_1286_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000914_1256_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000915_1150_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000916_941_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000920_1152_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000921_1346_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000922_1347_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000923_1353_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1000924_1353_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001002_1132_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001003_1133_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001004_1146_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001008_1162_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001025_1150_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001026_1152_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001027_1172_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001028_1199_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001029_1154_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001032_1227_1998-05-29.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001033_65535_1991-10-05.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001038_1257_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001039_1258_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001041_1187_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001042_1188_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001043_1189_1994-12-16.htm
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T1001046 Arabic Extended ISO/ASCII 8-Bit 1046 ASCII 

T1001068 Text With Numeric Spacing 1068 EBCDIC 

T1001069 Latin4 EBCDIC 1069 EBCDIC 

T1001087 Symbols, Adobe 1087 EBCDIC 

T1001091 Symbol Set 7, Modified 1091 EBCDIC 

T1001092 Symbol Set 7, Modified - PC 1092 ASCII 

T1001093 IBM LOGO 1093 EBCDIC 

T1001110 Latin2 Multilingual 1110 EBCDIC 

T1001111 Latin2 ISO/ANSI 8-BIT 1111 ASCII 

T1001112 Baltic - Multilingual, EBCDIC 1112 EBCDIC 

T1001122 Estonia, EBCDIC 1122 EBCDIC 

T1001123 Cyrillic, Ukraine EBCDIC 1123 EBCDIC 

T1001124 Cyrillic, Ukraine ISO-8 1124 ASCII 

T1001125 PC, Cyrillic Ukrainian 1125 ASCII 

T1001129 Vietnamese ISO-8 1129 ASCII 

T1001130 Vietnamese EBCDIC 1130 EBCDIC 

T1001131 PC, Cyrillic, Belo Russian 1131 ASCII 

T1001132 Lao EBCDIC 1132 EBCDIC 

T1001133 Lao ISO-8 1133 ASCII 

T1001139 Japan Alphanumeric Katakana 1139 ASCII 

T1001140 USA, Canada ECECP 1140 EBCDIC 

T1001141 Austria, Germany ECECP 1141 EBCDIC 

T1001142 Denmark, Norway ECECP 1142 EBCDIC 

T1001143 Finland, Sweden ECECP 1143 EBCDIC 

T1001144 Italy ECECP 1144 EBCDIC 

T1001145 Spain, Latin America ECECP 1145 EBCDIC 

T1001146 UK ECECP 1146 EBCDIC 

T1001147 France ECECP 1147 EBCDIC 

T1001148 International ECECP 1148 EBCDIC 

T1001149 Iceland ECECP 1149 EBCDIC 

T1001153 Latin2 Multilingual with Euro 1153 EBCDIC 

T1001254 Windows Turkish 1254 ASCII 

T1001257 Windows Baltic Rim 1257 ASCII 

T1001258 Windows Vietnamese 1258 ASCII 

T1001275 Apple Latin 1 1275 ASCII 

T1001276 Adobe PS Standard 1276 ASCII 

T1001277 Adobe PS ISO Latin 1 1277 ASCII 

T1001280 Apple Greece 1280 ASCII 

T1001281 Apple Turkey 1281 ASCII 

T1001282 Apple Central Europe 1282 ASCII 

T1001283 Apple Cyrillic 1283 ASCII 

T1001300 GENERIC BAR CODE/OCR-B 1300 EBCDIC 

T1005346 Latin 2 – Windows 1250 ASCII 

T1005347 Cyrillic – Windows 1251 ASCII 

T1005348 Latin 1 – Windows 1252 ASCII 

T1005349 Greece – Windows 1253 ASCII 

T1005350 Turkey – Windows 1254 ASCII 

T1005351 Israel – Windows 1255 ASCII 

T1005352 Arabic – Windows 1256 ASCII 

T1005353 Latin 4 – Windows 1257 ASCII 

T1005354 Vietnamese – Windows  1258 ASCII 

T1V10037 USA/Canada - CECP 37 EBCDIC 

T1V10273 Germany F.R./Austria- CECP 273 EBCDIC 

T1V10274 Belgium - CECP 274 EBCDIC 

T1V10275 Brazil - CECP 275 EBCDIC 

T1V10277 Denmark/Norway - CECP 277 EBCDIC 

T1V10278 Finlandd/Sweden- CECP 278 EBCDIC 

http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001046_1177_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001068_1259_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001069_1256_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001087_1257_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001091_1191_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001092_1191_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001093_2040_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001110_1111_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001111_1111_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001112_1305_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001122_1307_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001123_1326_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001124_1326_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001125_1331_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001129_1336_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001130_1336_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001131_1338_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001132_1341_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001133_1341_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001139_1122_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001140_695_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001141_695_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001142_695_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001143_695_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001144_695_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001145_695_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001146_695_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001147_695_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001148_695_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001149_695_1998-06-01.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001153_1375_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001254_1414_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001257_1421_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001258_1418_2002-07-04.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1001300_1450_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10037_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10273_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10274_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10275_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10277_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10278_697_1994-12-16.htm
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T1V10280 ITALY- CECP 280 EBCDIC 

T1V10281 Japan (Latin) - CECP 281 EBCDIC 

T1V10282 Portugal - CECP 282 EBCDIC 

T1V10284 Spain/Latin America - CECP 284 EBCDIC 

T1V10285 UNITED KINGDOM - CECP 285 EBCDIC 

T1V10290 Japan (Katakana) 290 EBCDIC 

T1V10297 France - CECP 297 EBCDIC 

T1V10500 International #5 500 EBCDIC 

T1V10871 Iceland - CECP 871 EBCDIC 

 

http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10280_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10281_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10282_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10284_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10285_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10290_1172_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10297_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10500_697_1994-12-16.htm
http://publib.boulder.ibm.com/printer/info/afpdb/codepages/T1V10871_697_1994-12-16.htm
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Appendix D. SBCS/DBCS/UTF-16BE AFP Codepages Summary 
 

 
Name Description Encoding 

T1H00037 Traditional Chinese EBCDIC EBCDIC 

T1H00290 Japanese Katakana Extended EBCDIC 

T1H00833 Korean EBCDIC EBCDIC 

T1H00836 Simplified Chinese EBCDIC EBCDIC 

T1H01002 Japanese DCF Rel 2 Compatibility EBCDIC 

T1H01027 Japanese Latin Extended  EBCDIC 

T1H01030 
Japanese Katakana Extended with Box 
Characters 

EBCDIC 

T1H01031 Japanese Latin Extended with Box Characters EBCDIC 

T1H01041 Japanese PC Extended  ASCII 

T1H01043 Traditional Chinese PC ASCII 

T1H01114 Traditional Chinese PC BIG5 with Euro ASCII 

T1H01115 Simplified Chinese PC (GB) ASCII 

T1H01126 Korean PC ASCII 

T1H01150 Korean EBCDIC with Box Characters EBCDIC 

T1H01151 
Simplified Chinese EBCDIC with Box 
Characters 

EBCDIC 

T1H01152 
Traditional Chinese EBCDIC with Box 
Characters 

EBCDIC 

T1H01159 Traditional Chinese EBCDIC with Euro EBCDIC 

T1H01252 Simplified Chinese PC (GB18030) ASCII 

T1HK0037 Japanese English  EBCDIC 

T1HK0290 Japanese Katakana  EBCDIC 

T10300, T1I300, 
T1J300, T1K300 

Japanese DBCS-HOST DBCS-HOST 

T10834 Korean DBCS-HOST (Small Set) DBCS-HOST 

T10835 Traditional Chinese DBCS-HOST DBCS-HOST 

T10837 Simplified Chinese DBCS-HOST (GB2312) DBCS-HOST 

T10941 Japanese SJIS-PC DBCS-PC 

T10947 Traditional Chinese  BIG5-PC DBCS-PC 

T10951 Korean KSC-PC (Small Set) DBCS-PC 

T11200 Unicode UTF-16 Big-endian UTF-16BE 

T11362 Korean KSC-PC (Big Set) DBCS-PC 

T11374 Traditional Chinese  HKSCS-PC DBCS-PC 

T11376 Traditional Chinese  HKSCS-HOST DBCS-HOST 

T11380 Simplified Chinese GB2312-PC (Small Set) DBCS-PC 

T11385 Simplified Chinese GBK-PC (Big Set) DBCS-PC 

T1K834 Korean DBCS-HOST (Big Set) DBCS-HOST 

T1K837 Simplified Chinese DBCS-HOST (GB18030) DBCS-HOST 



MakeAFP  
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